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About this Document 

 

IDI’s Core Release Bulletins describe new Core functionality introduced with the release through 
either Adaptive (AR) or Feature (FR) requests. Core functionality is defined as a capability that 
is available to all customers that upgrade to the release, although in some cases additional 
custom work may be required to use it. This document includes an overview of the new 
capabilities as well as the required configuration or setup information. Supporting 
documentation can be found on E-Support under Resources > Knowledge Center and 
Resources Help Resources.  

 

Additional training opportunities are also available through IDI University. Please contact your 
Account/Project Manager for more information. 
 

https://support.idibilling.com/onlinehelp.aspx
https://support.idibilling.com/onlinehelp.aspx
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 Release Summary 

1.1 CHANGE ORDERS/ENHANCEMENTS 

The following change orders and other enhancements are included in this release. 

 

Functional Area AR/FR Description 

Customer Care AR 8759 Service summary view on invoices 

The Invoice page has a new service summary view that displays invoice sub-totals by 
service including recurring charges, non-recurring charges, usage, and discounts. It 
also provides tax sub-totals, when available. This new view is available for all invoices. 

Security AR 8838 Web security logon to CostGuard Client and Admin Console 

This solution enables CostGuard users to log in to CostGuard Client and Admin 
Console with the CostGuard web security login used for web applications such as 
Customer Care and Workflow. This provides a consistent login experience and lets 
users take advantage of features such as OAuth login and password reset self-care.  
Authorized users can turn this functionality on and off. 

Orders AR 8795 Enhanced support for protection plans (such as Apple Care)  

Many service providers offer their customers device protection plans (service 
contracts) that help customers mitigate the expense when a device is lost or damaged. 
These plans can also provide a source of revenue for service providers. For some 
time, the CostGuard system has supported the sale of handset insurance as a monthly 
recurring charge product (MRC).  With version 21.7 and later, the CostGuard system 
provides a comprehensive solution for configuring, selling, and managing protection 
plans.  

• Configuration and Setup 

▪ The Product Catalog web application lets you set up protection plan profiles 
that establish rules for processing (including provisioning) different plans. 

▪ The Product Catalog in CostGuard Client lets you set up protection plan 
products for sale. You can set up billing products to sell on a recurring charge 
(MRC) basis, or retail products to sell on a pay-up-front basis. 

• Sales - The Orders web application and POS Make Sale in CostGuard Client 
support selling protection plans on a monthly recurring charge (MRC) basis or as 
a one time charge assessed at the time of sale. 

• Managing Plans - Customer Care lets you add, view, search and manage 
protection plans on an account. 
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1.2 RESOLVED KNOWN ISSUES 

The following known issues have been resolved in this release. 

 

Functional Area PR Description 

 

 

 

 

 

 

Payment 
Processing 

83701 Applying credits on inactive E-Pay accounts 

Web services were preventing users from applying credits to inactive E-Pay accounts.   

The Customer and Balance web services were enhanced to allow updates on refund 
transactions for inactive (end date expired) E-Pay accounts.  

Note: PR 83607 (CostGuard version 21.1) enhanced the Customer and Balance web 
services with respect to creating E-Pay transactions. PR 83701 extends this 
enhancement to modifying E-Pay transactions (e.g. applying a credit). 

83729 E-pay processing errors 

Running E-Pay could result in a large number of errors for certain flows that could lead 
to setting the RootEpayTransactionID and/or the RetryIndicator to NULL. This NULL 
value resulted in the error message that was reported.  

Logic has been added to handle the NULL scenarios to prevent the error.   

83745 PCI payment gateway error on setting OriginalNetworkTransactionID 

The PCI Payment Gateway Processing scheduled job was encountering an error when 
attempting to credit an E-Pay transaction with an OriginalNetworkTransactionID set but 
the E-Pay account being used did not have an OriginalNetworkTransactionID.  

This was fixed by adding a Null reference check.   

 

 

 

 

RateBill 

83636 Billing Log Warnings Received for Disconnected Products 

Warnings were received during Billing for expired tax jurisdictions. The errors were all for 
features that had been disconnected in the past and were not relevant to the current 
billing run. Billing has been updated so that validation is not done for historical features 
that are no longer billing. 

83737 XML validation issue 

When running Billing, there was an issue validating XML when enabling the setting 
Separate Taxes into Mandatory/Non-Mandatory Sections. The issue was due to a 
missing tag for the setting, and was only experienced when this setting was enabled. 
The CostGuard ifx.dtd file has been updated to define the missing element for this 
setting. 

Address 
Validation 

83738 Order failures due to missing tax jurisdiction 

The Address Validation Management web service documentation has been updated to 
change fipsCode to taxFips in the response to the Validate Address Post operation. 
Additionally, the rawResultCode has been documented. There was no code change 
related to this. The issue was simply due to a documentation bug. 

Bulk Data 83719 BulkData Displays Incorrect Process Time 
When viewing the File Details for a Bulk Data import in the Bulk Data web application, 
the Process Time would only display one digit for hour (H:MM:SS). The hours displayed 
would be incorrect if the value was 10 or higher.  

The display of Process Time has been updated to display two digits (HH:MM:SS). 

 

Workflow 
Provisioning 

83695 Object reference error when  response from MetaSwitch didn’t contain 
ExtendedSubResults 

An Object reference error was occurring when provisioning to Metaswitch in some 
scenarios. This was due to not properly handling when a response from MetaSwitch 
lacked ExtendedSubResults.  

A NULL check was added to the ExtendedSubResults field so that when responses do 
not contain the results, an error will not occur. 
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Functional Area PR Description 

 

 

 

Workflow 
Provisioning 

83710 List drop down limited to 20 items when scrolling available values 

In Workflow Provisioning, the List drop downs were limiting the avalable values to the 

first page of 20 values. Users could use the type ahead functionality to locate the desired 

value; however, when trying to scroll through the list values, only the first 20 were 

displayed. 

This has been corrected so that users can scroll through entire sets of values in the list. 

83722 User-Defined List Removal of New Value Errors 

Adding an element to a user-defined list, removing the item by clicking X,  and then 
saving resulted in an Internal Server Error.  

The Manage Lists page has been updated so that adding a new item to the list and then 
removing it will not cause the Internal Server error upon saving. 

Batch File 
Processing 
(Customer 
Management 

83736 VOID Unbilled Adjustment Files 

Duplicate adjustments batch files were uploaded in error and attempting to void the 
duplicate records resulted in an error. This occurred as a result of loading batchfiles and 
creating multiple BCMRequest entries with a BCMRequestTypeId = 1. Void logic for 
payments and adjustments deletes the duplicated records in that batch by looking up 
those records based on the BatchFileID.  When there is more than one BCMRequest for 
the same BatchFileID the query to identify those records presented an error.  The logic 
for creating the BCMRequest was updated to only happen when there are no 
BCMRequest created for the current file. 

Note: While this PR will fix this functionality going forward, contact IDI Support if you are 
receiving critical error messages when attempting to void batch files. 
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 Service Summary View on Invoices 
The Invoice page in Customer Care has a new service summary view that displays invoice sub-
totals by service including recurring charges, non-recurring charges, usage, and discounts. It 
can also provide tax sub-totals when the system is configured to support this.  

2.1 TOGGLING INVOICE VIEWS 

A new view selector in the upper right corner lets you toggle between these invoice views: 

• Invoice Summary – This is the original and default view. It presents the entire invoice 
amount, including both account- and service-level charges and credits. No changes 
have been made to this view. 

• Service Summary – This is the new view that displays sub-totals by service.  

• Corporate Hierarchy – This option is only available for corporate accounts. No 
changes have been made to this view. Note: Prior to CostGuard version 21.7, the 
corporate hierarchy was available via a View Hierarchy link at the top right portion of 
the page. The Corporate Hierarchy option in the view selector replaces the View 
Hierarchy link. 
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2.2 SERVICE SUMMARY VIEW 

This view provides a summary of charges associated to each service number on the invoice 
being viewed. This view is not intended to reconcile the entire invoice amount, as account-level 
charges and credits are not included in this view. The left pane displays the total service-level 
charges on the invoice and the sub-totals for each service number. 

 

 
 

Paging will occur if there are more than 15 services. The Search tool lets you look for a specific 
service number when there are a large number of services. Partial matches are supported for 
service number searches. 

 

Clicking on a specific service number in the left pane displays the sub-totals for that service 
number by invoice category in the right pane. Totals for usage, recurring charges, non-recurring 
charges, taxes (if available), and discounts are provided. 
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 TAX INFORMATION 

As part of this feature, Billing has been enhanced to write service-level tax information to the 
core database when generating invoices. This information is used to display the tax amount for 
each service on the Service Summary view.  

Note: For tax sub-totals to be available on the Service Summary view (and available in the core 
database), the Round Taxes by Service Number setting must be enabled for the CostGuard 
environment. This is an existing setting that also impacts other areas in the CostGuard system 
(in addition to the Service Summary invoice view). This setting is not accessible by CostGuard 
users and must be set by an authorized IDI associate. If you wish to make tax information 
available in the Service Summary contact IDI Support to learn more about this setting and 
arrange to have it enabled. 

 

 
 

When viewing an invoice where the tax information is not available, an informational icon will be 
displayed. Clicking the icon displays text indicating these totals do not include taxes. 

 

 
 

In the case where taxes are not included, the Taxes amount will not be displayed on the right 
side of the page when viewing the sub-totals for the service number. 

Note: Historical invoices (generated prior to being on CG 21.7 or higher) will not have service-
level tax information available for this view. 
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2.3 COMPARING SERVICE SUMMARY TOTALS 

Clicking the Compare option lets you compare the service summary totals on the current 
invoice with other invoices for the account.  

 

 
 

You can select which invoices to compare using the bill period (month) drop down menus. 
Clicking on a specific service number will display a comparison of the invoice category amounts 
for that service number in the selected bill periods. Differences are presented on the invoice-
level in the left pane, and by category in the right pane. 

You can exit the compare mode and return to the Service Summary by clicking Back to Service 
Summary in the upper right corner. 

 

 
 

Note: If either invoice does not have tax information available, the tax amounts will not be 
included even if they are available on one of the invoices when in compare mode. 
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2.4 SERVICE TAX DETAILS 

When the Round Taxes by Service Number setting is enabled for the CostGuard environment 
(see Tax Information above). Billing writes additional invoice tax detail information to a new 
table in the core database. This data will be available in core replicated data. The new table is 
called InvoiceServiceTaxDetail. It contains the following columns: 

• InvoiceServiceTaxDetailID (Internal unique identifier) 

• InvoiceNumber 

• CustID 

• UsgSvcID (not populated for account-level taxes) 

• TaxID 

• Amount 
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 Web Security logon to CostGuard Client 
This solution enables CostGuard users to log in to CostGuard Client and Admin Console with 
the same web security login used for web applications such as Customer Care. This provides a 
consistent login experience and lets users take advantage of features such as OAuth login and 
password reset self-care.  Authorized users can turn this functionality on and off. 

SETUP 

Integrated Security through the Security web module is a requirement for using Web Login.  

 

 
 

Also, Web login must be enabled at the environment level via the Admin Console by navigating 
to Security > Settings > Web Login Setting.  Check Enable Web Login and save.  This enables 
Web login for the environment where you’re currently logged in.  

 

 
 

To enable Web Login for a different environment, sign out and then sign into that environment 
and follow the same steps.  

 

Note: Work with IDI Account Management to add/configure OAuth providers.  
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3.1 HOW WEB LOGIN WORKS FOR COSTGUARD CLIENT  

When this functionality is enabled for your current environment, selecting the CostGuard client 
or Admin Console launcher directs you to the Web Login form. This form lets you enter your 
integrated security username and password, or you can use your OAuth login for your provider. 

You can also select the environment where you wish to log in via the Environment drop down 
menu. This menu contains all environments where this functionality is enabled. 

  

 
 

If your default environment is not configured to use web login, you’ll will see the original login 
form.  

 
 

For both the Web login and original login forms, a login error will display if the login information 
is not correct.  
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When switching between environments that use Web Login and ones that do not, you’ll see a 
loading screen as the appropriate login form is loaded.  

 
 

If you forget your password, you can use the Forgot Password Link on the Web Login form to 
start the process for resetting your password.  

 

 
 

This will require you to answer a security question to verify your identity. 
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Security questions are managed in CostGuard Client via Tools > Manage Security Questions.  

 

 
 

Selecting this option will open a web browser and navigate the user to a page where they can 
set answers to security questions. These questions are used as part of the Forgot Password 
flow on the Web Login form. Please note that the Forgot password Link will not work if there are 
no security questions set for the user.  

 

 

 SPECIAL LOGINS 

This functionality supports the following Internal IDI logins used by internal IDI users for set up, 
maintenance, and configuration: 

• Shell GUI 

• Task Editor 

• Workbook Editor 

• Login for running kit   

 

Note: The Supervisor Login and Manager Override do not use Web Login.  
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 Configuring, Selling and Managing Protection Plans 
Many service providers offer their customers device protection plans (service contracts) that 
help customers mitigate the expense when a device is lost or damaged. These plans can also 
provide a source of revenue for service providers. For some time, the CostGuard system has 
supported the sale of handset insurance as a monthly recurring charge product (MRC).  With 
version 21.7 and later, the CostGuard system provides a comprehensive solution for 
configuring, selling, and managing protection plans.  

 

• Configuration and Setup 

▪ The Product Catalog web application lets you set up protection plan profiles that 
establish rules for processing (including provisioning) different plans. 

▪ The Product Catalog in CostGuard Client lets you set up protection plan products 
for sale. You can set up billing products to sell on a recurring charge (MRC) basis, 
or retail products to sell on a pay-up-front basis. 

• Sales - The Orders web application and POS Make Sale in CostGuard Client support 
selling protection plans on a monthly recurring charge (MRC) basis or as a one time 
charge assessed at the time of sale. 

• Managing Plans - Customer Care lets you add, view, search and manage protection 
plans on an account.  

Benefits of this solution include: 

• Charging for plans at point of sale (pay up front) or billing on a recurring basis. 

• Performing real time eligibility checks with the third-party plan adminitrator during the 
Sale/Fulfillment.  

• Enrolling equipment in a plan with or without a line of service.  

• Selling a plan in a fulfillment model where the equipment ID is not known at the time of 
sale.  In this case an eligibility check must occur at the time of fulfillment.  

• Enforcing cancelation and refunding rules as may be required by the third-party 
administrator.  

• Disconnecting, hotlining or suspending a line of service without losing coverage for the 
device.  

 

4.1 ADDING AND MANAGING PROTECTION PLAN PROFILES  

Protection plan profiles specify rules for processing protection plans, including provisioning 
settings if needed. Profiles are set up in the Product Catalog web application.  Note: Set up 
profiles before configuring protection plan products in CostGuard Client Product Catalog as the 
protection plan profiles must be specified when you configure the products. 
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To begin, access the Product Catalog web application via the web Apps tray. 

 

 
 

In Product Catalog navigate to the Protection Plan Profiles page by choosing MANAGE > 
Protection Plan Profiles. 

 

 
 

The Protection Plan Profiles page lists the existing profiles and lets you: 

• add new profiles 

• display a detail view where the selected profile can be edited 

• enter search criteria to filter the profile list and make it easier to navigate 

 

 



  

IDI Billing Solutions | Confidential |  18 

 

7615 Omnitech Place | Victor, NY 14564 

www.idibilling.com 

 

 ADDING A NEW PROFILE 

A profile consists of a Name, Description, Type, and Provisioning Settings. Click +NEW 
PROFILE to display the New Protection Plan Profile dialog. 

 
Use this dialog to specify: 

• Profile Name - This is the only required field. 

• Description – This is optional. 

• Type – This can drive downsteam functionality as may be required by a plan covering 
a specific device (e.g. fields that may be needed to complete enrollment). The drop 
down menu defaults to blank (null entry) which sets the Type to Generic. Apple Care is 
also available as a Profile Type. Note: Other Profile Types can be created via the 
Adaptive Request process. 

• Provisioning Settings – These settings only apply if you’re using CostGuard 
Provisioning to provision the plan. These settings are disabled by default. To enable 
the fields (only if needed), toggle the enable/disable button at the far right (shown 
enabled). 
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Once enabled you can specify the following: 

▪ Provisionable Object Code - Enter the provisionable object code that was 
configured in the Provisioning application.   

▪ Enroll Profile – This is the provisioning profile (as configured in Provisioning) to 
use on provisioning request to enroll a device in a plan. 

▪ Cancel Profile – This is the provisioning profile to use on canceling a plan. 

▪ Require Verification – If you choose to require verification, any protection plan 
that uses this profile must be verified by the 3rd party plan adminsitrator before you 
add the plan to a customer’s account and enroll the customer in the plan.  Use the 
Require Verification button to toggle this functionality on/off.  When on, the 
Verification Profile drop down menu is enabled and a profile must be selected. The 
verification step is completed when you add/sell a plan using this profile. 

▪ Verification Profile - This is the provisioning profile (as configured in Provisioning) 
to use when the verify provisioning request is sent. 

▪ Custom Queries – This section lets you add provisioning actions (in addition to 
Enroll and Cancel) as may be required by your third-party protection plan 
administrator. Enter a unique NAME. This field does not allow spaces.  Use the 
underscore in lieu of a space.  Then select a Provisioning Profile (configured in the 
Provisioning web app) from the PROFILE drop-down menu. Any custom queries 
you add will be available in the Actions drop-down menu on the protection plan’s 
Detail view in Customer Care. Note: The NEW QUERY button is only available 
when Provisioning Settings is enabled.   

 

 

 VIEWING/EDITING PROFILE DETAILS 

You can display a detail view for an existing profile by clicking the on the Name link. 

 
 

The detail view is equivalent to the New Plan Profile dialog and lets you edit profile parameters. 
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4.2 SETTING UP PROTECTION PLAN PRODUCTS IN THE COSTGUARD 

CLIENT PRODUCT CATALOG 

You can set up recurring charge and pay-up-front protection plans in CostGuard Client Product 
Catalog. Pay-up-front plans are configured as retail products. Recurring charge plans are 
configured as billing products (or packages). In both cases, the products must be assigned to a 
Protection Plan Product Class and be associated to a specific Protection Plan Profile.  

 

 CONFIGURING A PAY UP FRONT PLAN 

To set up a pay up front plan: 

• Create a new retail product.  

• Set the Product Class to Protection Plan.  

• Select the profile from the Protection Plan Profile drop down menu (enabled when 
Product Class = Protection Plan).  

• As an option you can also override the Register Policy setting for Refund Days Limit  
as may be required when your third-party plan administrator’s rule for refunds (number 
of days limit) differs from your business rules. 

▪ The Override Value is only editable and observed when Is Overridden is 
checked (enabled). The value can be any integer greater than or equal to 1. 

▪ When an override is specified, the logic that observes Max Refund Days in 
CostGuard Client, Order Placement and Catalog Service web services will observe 
the override rather than the Register Policy setting. 
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 CONFIGURING A PLAN FOR RECURRING BILLING 

To set up a recurring charge plan: 

• Create a new billing product or package.  

• Set the Product Class to Protection Plan.  

• Select the profile from the Protection Plan Profile drop down menu.  
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4.3 SELLING PROTECTION PLANS IN THE ORDERS WEB APPLICATION 

You can add products or packages marked with a Product Class of Protection Plan to an order 
just like you would any other item (Orders Web App > New > select customer > Add Item). 
Note: Add the monthly recurring charge product at the customer account level.  This lets 
subscribers disconnect their line of service and still maintain a protection plan agreement.   

 

When items with Product Class = Protection Plan are staged, you can use the View menu to 
select Protection Plan Information to enter the information required to enroll in the plan. 

 

 
 

Fields for Serial Number, Activation Date, Cancellation Date and Contact Information are 
common to all protection plans. Additional information may be required depending on the profile 
on which the plan is based, for example Apple Care Information as shown below. An asterisk (*) 
denotes a required field, and any required fields left NULL will highlight yellow if you attempt to 
click ADD TO ORDER, and the item will not be added. 
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If you add a package that has protection plan packages or products within it, all protection plans 
will stage, along with the root-level package itself: 

 
 

Only items with Product Class = Protection Plan will have Protection Plan Information 
available in the View menu, and any required information must be filled in for all staged items 
before ADD TO ORDER will proceed with adding all items currently staged. 

 

Once added to an order, you can still make changes to the protection plan information by re-
staging it (clicking on the item) and clicking the Edit icon. The item can also be taken out of the 
order with the Remove icon. This can be done as many times as necessary prior to submitting 
the order. 

 

Note: Once the order is complete, the protection plan will be listed on the Protection Plans page 
on the account in Customer Care. 
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 VERIFYING A PROTECTION PLAN THROUGH ORDERS 

If verification is required for the selected protection plan profile, the protection plan cannot be 
added to the order until verification has completed successfully. Similarly, if verification was 
completed, but then information on the form was changed, the protection plan cannot be added 
until the information is re-verified successfully. 

 

VERIFY button state changes: 

 

• If verification is allowed but has yet to occur, the icon on the button will be black and 
white 

 

• Once verification has successfully been completed, the icon will convert to a green 
shield with a check mark 

 

• If the selected protection plan profile is configured to require verification and 
verification has yet to occur (or information on the page was changed since the last 
successful verification), the shield will be red to indicate requires verification. 

 

 

Note: If the protection plan being added has a protection plan profile that allows verification (a 
Verification Profile is configured), the VERIFY button will be available; even if a protection plan 
is unchanged and verification was successful. You can always re-verify. The last verification 
must have been successful for the protection plan to be added to the order. 

 

If verification fails in the Orders web application, the system will produce an error message.   
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4.4 SELLING PROTECTION PLANS IN POS MAKE SALE 

When a product, package, or retail product with Product Class = Protection Plan is sold 
through POS, the Make Sale Wizard includes an additional Protection Plan Information page 
with required and optional fields be filled in before proceeding. Serial Number, Activation Date, 
Cancellation Date, and Contact Information fields are common to all plans. Additional field may 
be displayed depending on the associated protection plan profile. For example, if the plan’s 
associated profile type is Apple Care, the Apple Care Information fields will also display with the 
Language Code, POC Delivery Preference, and POC Language Code being required.   

Note: The serial number will be auto-populated if a serialized handset was sold earlier in the 
Make Sale flow.  

 

 
 

 

If the protection plan profile is configured to allow verification (a Verification Profile is assigned), 
the Verify button will be available, and you cannot proceed to the next page without Verification 
if the has not completed successfully. 

 

The verification on this screen follows the same business rules as verification in Orders and 
Customer Care, in that if required, you cannot proceed until a successful verification, and if 
information on the screen is changed between successful verification and proceeding to the 
next page, the plan must be successfully verified again to continue. 
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If verification fails in POS, hover over the red X to review the error message.   
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4.5 ADDING AND MANAGING PROTECTION PLANS ON AN ACCOUNT 

Customer Care lets you add and manage protection plans on an account independent of POS 
or web-based Orders. Management functions include enrolling and canceling. Other options 
may also be available, depending on the profile configuration. This functionality is available by 
selecting Account > Protection Plans from the Customer menu.  

 

 
 

This displays the Protection Plans page.  

 

 
Whether or not the plan is active is indicated in the far left column: 

• Green check = active (enrolled) 

• Red X = inactive (canceled) 

• Blank = no actions have been performed on this plan 

 

 
 

From the Protection Plans page you can add a new plan, display a detail view for a selected 
plan where you can submit an enroll or cancel request, or export the Protection Plans list. 
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 ADDING A NEW PLAN 

Note: There is no associated charge when adding plans to an account in this manner.   

If you need to collect revenue for the plan, it is recommended to create an order.   

 

To add a new plan, click +NEW PROTECTION PLAN in the upper right side. This displays the 
New Protection Plan dialog. 

 

 
 

From here specify: 

• Protection Plan Profile – Select a protection plan profile from the drop down menu. 
This field is required. 

• Serial Number – Enter the device serial number. This field is required. 

• Enroll Now – You can choose to enroll the device in the plan on a specified activation 
date by checking this box, or defer enrollment until later. An enrollment action is 
available via the Plan Detail view if you choose not to enroll now. 

• Activation Date – This field is enabled when you check the Enroll Now check box. 
Select a date on which to enroll in the plan. If Enroll Now is not checked this field is 
disabled. 

• Contact Information – You may fill in the individual fields to specify a contact other 
than the customer or click COPY CUSTOMER ADDRESS to auto-fill using the 
customer information. 
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Note: If the selected protection plan profile has been configured to require verification, you won’t 
be permitted to save and submit an enroll request on the account until you verify the profile by 
clicking the VERIFY button in the upper right corner. 

 

 
If the verification is successful, you’ll see a green banner to indicate success. 

 
 

Additional Apple Care Fields 

The following required fields are displayed when the associated profile type is Apple Care:  

• Language Code  

• POC Language Code   

• POC Delivery Preference   

• Cancel Reason Code  

 

  

The values in these drop-down menus are driven by Workflow Management configuration.  
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 VIEWING/EDITING PLAN DETAILS 

The detail view lets you edit information entered when the plan was added. It provides a history 
of provisioning actions for the plan. The Actions menu lets you initiate provisioning actions. To 
display the detail view for a plan, click the Serial Number link. 

 

 
The content of the Actions menu depends on the plan’s current enrollment status as well at the 
profile configuration.  

• The Actions menu provides both Enroll and Cancel options when no requests have 
been submitted yet. Note: Cancel may apply here because the plan may have a 
pending activation date (set up using the Enroll Now option).  

• If the plan is currently enrolled (indicated by a green check) the only option available is 
Cancel. Likewise, if the plan has been canceled (indicated by a red X) the only option 
is to Enroll. 

• Additional options are provided if the associated profile has custom queries configured 
to support custom provisioning actions. 
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The Activity history grid lists all Enroll and Cancel requests. 

 

 
 

When provisioning is required, the Status is Pending until the request is completed. The Activity 
history for a plan can be exported to a spreadsheet by clicking the Export link below the list. 

 

Enrolling in a Plan 

If you deferred enrollment when the plan was added, or if you subsequently canceled the plan, 
you can enroll/re-enroll via the detail view. To do this choose Actions > Enroll. This displays a 
dialog to specify an Activation Date (defaults to today). 

 

 

Canceling a Plan 

To cancel an active plan, choose Actions > Cancel. This displays a dialog for specifying the 
cancelation date. 
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Custom Provisioning Actions 

The Actions menu provides additional provisioning actions if the profile associated to the 
selected plan has custom queries configured.  

  

  

Each menu option will invoke the query operation with the name of the query, wait for the 
provisioning request to complete, then display the contents of the response once completed.  

  

This is similar to existing Switch Query functionality, which is available on the Services and 
Features page in Customer Care under the Query menu (in the right pane when you select an 
item in the left pane). 

  

Note: You won’t be permitted to initiate another activity if one is currently in process.  

  

 PROTECTION PLAN SEARCH 

The OmniSearch in Customer Care has an option to search on Protection Plan Activity. 

 

 
 

The basic search lets you enter an account or serial number. More Options provides additional 
criteria including activity, profile type, modify date and provisioning status. 
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The results list details for matches found. Clicking a link in the Account Number column opens 
the applicable customer account. Clicking the link in the Status column opens a new tab 
showing the applicable provisioning request in the Provisioning web application. 
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4.6 TRIGGER SUPPORT 

When a Protection Plan is Created, Canceled, Enrolled, or Updated, triggers are now supported 
such that a Workflow can be configured to fire an action when one of these events occurs.  

  

To be clear, these triggers are not to Create, Cancel, Enroll, or Update a Protection Plan, but 
rather when those activities occur on a Protection Plan, a Workflow can be configured such that 
an event will fire off to send an email, create a follow-up, or any other trigger-induced action.  

  

Configurable Trigger Information:  

• Protection Plan ID  

• Protection Plan Profile ID  

• Activation Date*  

• Cancellation Date*  

• Customer ID  

• Protection Plan Status ID*  

• Protection Plan Request Status ID*  

• Auditable Fields  
  

*Include ‘_Old’ (ex. There will be 'ActivationDate' as well as 'ActivationDate_Old')  
 
Example: 
 

 
  
  

 

 


